ModusToolbox™
CAPSENSE™ Tuner guide

About this document

Version
4.0

Scope and purpose
The CAPSENSE™ Tuner is used to tune CAPSENSE™ applications.

Intended audience
This document helps application developers understand how to use the CAPSENSE™ Tuner as part of creating a ModusToolbox™ application.

Document conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>Emphasizes heading levels, column headings, menus and sub-menus</td>
</tr>
<tr>
<td>Italics</td>
<td>Denotes file names and paths.</td>
</tr>
<tr>
<td>Courier New</td>
<td>Denotes APIs, functions, interrupt handlers, events, data types, error handlers, file/folder names, directories, command line inputs, code snippets</td>
</tr>
<tr>
<td>File &gt; New</td>
<td>Indicates that a cascading sub-menu opens when you select a menu item</td>
</tr>
</tbody>
</table>

Abbreviations and definitions

The following define the abbreviations and terms used in this document:

- Application – One or more projects related to each other.
- CAPSENSE™ – capacitive sensing
- Configurator – A GUI-based tool used to configure a resource.
- CSD – self-capacitance sensing method
- CSX – CAPSENSE™ Transmit/Receive (CAPSENSE™ with two electrodes: Tx and Rx), mutual capacitance sensing method
- IDE – integrated development environment
- MSC HW – A multi sensing converter, a hardware block – the latest hardware block, which supports the CSX and CSD sensing methods.
- Peripheral – Any external analog or digital device that provides an input and output for the computer.
- PSoC™ – programmable system-on-chip
- Widget – A CAPSENSE™ functional unit consisting of one sensor or a group of similar sensors, implementing a specific higher-level functionality such as Button, Proximity Sensor, Linear Slider, Radial Slider, Matrix Buttons or Touchpad.
Reference documents

Refer to the following documents for more information as needed:

- [Eclipse IDE for ModusToolbox™ user guide](#)
- [CAPSENSE™ Configurator guide](#)
- [Device Configurator guide](#)
- [PDL API reference guide](#)
- Device datasheets
- Device technical reference manuals
Table of contents

1 Overview .................................................................................................................. 5
2 Launch the CAPSENSE™ Tuner ............................................................................. 6
  2.1 From the Device Configurator ............................................................... 6
  2.2 make command .................................................................................. 7
  2.3 Eclipse IDE ....................................................................................... 7
  2.4 Executable (GUI) ............................................................................. 8
  2.5 From the Command Line ................................................................. 8
3 Quick start ............................................................................................................. 9
4 GUI description .................................................................................................... 11
  4.1 Menus .............................................................................................. 11
  4.2 Toolbar ............................................................................................ 12
  4.3 Widget Explorer pane ....................................................................... 13
  4.4 Widget/Sensor parameters pane ...................................................... 14
  4.5 Tabs .................................................................................................. 14
  4.6 Status bar ....................................................................................... 15
5 Tuner Communication Setup .............................................................................. 16
6 Widget View tab .................................................................................................. 17
  6.1 Touch Signal Graph ........................................................................... 17
  6.2 Toolbar ............................................................................................ 17
7 Graph View tab .................................................................................................. 18
  7.1 Toolbar ............................................................................................ 18
  7.2 Graph functionality ........................................................................... 18
8 SNR Measurement tab ...................................................................................... 20
  8.1 SNR options .................................................................................... 22
  8.2 SNR Measurement procedure ........................................................... 23
9 Touchpad View tab .............................................................................................. 24
  9.1 Toolbar ............................................................................................ 24
  9.2 Widget selection .............................................................................. 24
  9.3 Display settings ................................................................................ 24
  9.4 Show signal ..................................................................................... 25
  9.5 Touch report ..................................................................................... 25
10 Gesture View tab ............................................................................................... 26
  10.1 Toolbar ........................................................................................... 26
  10.2 Widget selection .............................................................................. 26
  10.3 Image pane ..................................................................................... 26
  10.4 Gesture Monitor .............................................................................. 27
  10.5 Gesture Event history ..................................................................... 27
11 Tuner Configuration options .............................................................................. 28
Table of contents

11.1 Display options........................................................................................................................................... 28
11.2 SNR options................................................................................................................................................... 29
11.3 Logging options........................................................................................................................................... 29

12 Troubleshooting ............................................................................................................................................... 30

13 Version changes ............................................................................................................................................... 31
1 Overview

The CAPSENSE™ Tuner is a stand-alone tool included with the ModusToolbox™ software. The tool is used to tune CAPSENSE™ applications.

Prior to using the CAPSENSE™ Tuner, create a CAPSENSE™ application and program it into the device. Refer to the [CAPSENSE™ Configurator guide](#) and the [CAPSENSE™ middleware documentation](#) for help. Your application must contain the CAPSENSE™ Middleware and a communication interface (I2C or UART). The Tuner works with the KitProg3, MiniProg4, and UART devices.
2 Launch the CAPSENSE™ Tuner

There are several ways to launch the CAPSENSE™ Tuner, and those ways depend on how you use the various tools in ModusToolbox™. However, the easiest way is to launch it using the Device Configurator because the CAPSENSE™ Tuner requires a properly configured CAPSENSE™ application programmed into the device. Refer to the Device Configurator guide for more details.

2.1 From the Device Configurator

You can launch the CAPSENSE™ Tuner from the Device Configurator. Refer to the Device Configurator guide for more details.

The process to launch the CAPSENSE™ Tuner from the Device Configurator differs slightly for device families with the CSD hardware block and those with the MSC hardware block. There is only one resource for the CSD hardware block, while there is more than one resource for the MSC hardware block.

1. On the Peripherals tab, select the CSD (CapSense) resource or the CapSense and one or more MSC resources, as applicable for your device.

2. On the Parameters pane, select an appropriate input Clock.

3. For the MSC hardware block only, select the CapSense resource category on the Peripherals tab.
Launch the CAPSENSE™ Tuner

4. On the Parameters pane, click the Launch CapSense Tuner button.

![Parameters pane with Launch CapSense Tuner button highlighted]

2.2 make command

As described in the ModusToolbox™ user guide Build System chapter, you can run numerous make commands in the application directory, such as launching the CAPSENSE™ Tuner. After you have created a ModusToolbox™ application, navigate to the application directory and type the following command in the appropriate bash terminal window:

```
make open CY_OPEN_TYPE=capsense-tuner
```

This command opens the CAPSENSE™ Tuner GUI for the specific application in which you are working.

2.3 Eclipse IDE

If the selected application already includes a configuration (design.cycapsense) file, you can launch the CAPSENSE™ Tuner from the Eclipse IDE. Right-click on the project in the Project Explorer and select ModusToolbox™ > CapSense Tuner <version>. You can also click the CapSense Tuner link in the IDE Quick Panel. Refer to the Eclipse IDE for ModusToolbox™ user guide and CAPSENSE™ Configurator guide for more details.

![Eclipse IDE with ModusToolbox and CapSense Tuner highlighted]

Note: These steps are the minimum required to launch the CAPSENSE™ Tuner. However, the Tuner will not work without a properly configured CAPSENSE™ application programmed into the device.
Launch the CAPSENSE™ Tuner

2.4 Executable (GUI)

You can launch the CAPSENSE™ Tuner GUI by running its executable as appropriate for your operating system (for example, double-click it or select it using the Windows Start menu). By default, the CAPSENSE™ Tuner is installed here:

<install_dir>/ModusToolbox/tools_<version>/capsense-configurator<version>

When run independently, the application opens without any information. You need to open a specific CAPSENSE™ application configuration file that was created by the CAPSENSE™ Configurator for the Tuner to work. See Menus for more information about opening a configuration file.

2.5 From the Command Line

You can run the Tuner from the command line. However, there are few reasons to do this in practice.

For information about the command-line options, run the Tuner using the –h option.
Quick start

This section provides a simple workflow for how to use the CAPSENSE™ Tuner.

1. Create a CAPSENSE™ application with a tuner communication interface, and program the application into the device. Refer to the Eclipse IDE for ModusToolbox™ user guide and the CAPSENSE™ Configurator guide for more details.

   Note: You can also use the PSoC 6 CapSense Buttons and Slider code example configured to work on PSoC™ 6 MCU kits or PSoC 4 MSC CapSense CSD Button Tuning to work on PSoC™ 4 MCU kits.

2. Launch the CAPSENSE™ Tuner.

3. Start Communication. Click Connect and select the protocol. In this case – “I2C.”

   ![CAPSENSE Tuner Interface]

   Note: Refer to the KitProg user guide for supported configurations and modes. For this example, I2C address, sub-address, and speed must match the configuration.

   For the I2C communication, the Tuner only supports the 2-Bytes Sub-address.

4. Click Start to extract data.

5. Touch the sensors on the hardware and notice the change in the sensor/widget status on Widget View Tab.

6. Open the Graph View tab. Check the sensors in the Widget Explorer Pane to observe sensor signals in the graph. Touch the sensors and notice the signal change on the Graph View Tab.

7. Change widget/sensor parameter values as needed. Then, apply the new settings to the device using the Apply to Device button.
Quick start

You can do this when using Manual or SmartSense (Hardware parameters only) modes for tuning:

- To edit the threshold parameters, use SmartSense (Hardware parameters only) mode.
- To edit all the parameters, use Manual mode.
- When SmartSense (Full Auto-Tune) is selected for CSD tuning mode, parameters are read-only (except the Finger Capacitance parameter).

9. Save the Tuner parameters. Click the **Apply to Project** button.

10. Exit the Tuner application.
GUI description

The CAPSENSE™ Tuner application contains menus, a toolbar, panes, tabs, and a status bar, all used to tune a CAPSENSE™ application.

4.1 Menus

4.1.1 File

- **Open…** – Opens a <file_name>.cycapsense configuration file. This command is visible only when running the Tuner independently from the Eclipse IDE.
- **Apply to Device** – Commits current values of a widget/sensor parameter to the device. This command becomes active if a value of any configuration parameter from the Tuner application changes (that is, if the parameter values in the Tuner and the device are different). This is an indication to apply the changed parameter values to the device.
- **Apply to Project** – Commits current values of a widget / sensor parameter to the CAPSENSE™ project.
- **Open in System Explorer** – This opens your computer's file explorer tool to the folder that contains the *.modus file.
- **Import…** – Imports a specified configuration file.
- **Export…** – Exports the current configuration file into a specified file.
- **Recent files** – Shows recent files that you can open directly.
- **Exit** – Asks to save changes if there are any and closes the Tuner. Changes are saved to the configuration file.

4.1.2 Edit

- **Undo** – Undoes the last action or sequence of actions.
- **Redo** – Redoes the last undone action or sequence of undone actions.
4.1.3 View
- **Widget Explorer** – Hides or shows the Widget Explorer pane where widgets and sensors tree display.
- **Widget/Sensor Parameters** – Hides or shows the Widget/Sensor Parameters pane.
- **Gesture Event History** – Logs the detected gestures information. Displays in the View when any gesture is available.
- **Gesture Monitor** – Provides visual indication for a detected gesture. Displays in the View when any gesture is available.
- **Toolbar** – Hides or shows the Toolbar. Enabled by default.
- **Reset View** – Resets the view to the default.

4.1.4 Communication
- **Connect** – Connects to the device via a communication channel selected in the Tuner Communication Setup dialog. If the channel was not previously selected, the Tuner Communication dialog is shown.
- **Disconnect** – Closes the communication channel with the connected device.
- **Start** – Starts reading data from the device.
- **Stop** – Stops reading data from the device.

4.1.5 Tools
- **Tuner Communication Setup…** – Opens the configuration dialog to set up a communication channel with the device.
- **Options…** – Opens the configuration dialog to set up different tuner preferences.

4.1.6 Help
- **View Help** – Opens the CAPSENSE™ Tuner guide (this document).
- **About CapSense Tuner** – Opens the About box to display the version information.

4.2 Toolbar
Contains frequently used buttons that duplicate the main menu items:
- ![Configuration Dialog](image) – Opens the configuration dialog to set up a communication channel with the device. The same as the Tools > Tuner Communication Setup menu command.
- ![Connect](image) – Connects to the device via a communication channel selected in the Tuner Communication Setup dialog. The same as the Communication > Connect menu command.
- ![Disconnect](image) – Closes the communication channel with the connected device. The same as the Communication > Disconnect menu command.
- ![Start](image) – Starts reading data from the device. The same as the Communication > Start menu command.
- ![Stop](image) – Stops reading data from the device. The same as the Communication > Stop menu command.
- ![Open File](image) – Opens a configuration file. The same as the File > Open menu command.
GUI description

- Commits current values of a widget/sensor parameter to the device. The same as the File > Apply to Device menu command.
- Commits current values of a widget / sensor parameter to the CAPSENSE™ project. The same as the File > Apply to Project menu command.
- Imports a specified configuration file. The same as the Import menu command.
- Exports the current configuration file into a specified file. The same as the Export menu command.
- Starts or stops data logging into a specified file.
- Read mode – Selects the Tuner communication mode with a device. The following options are available (under the I2C communication interface):
  - Synchronized – When selected, application firmware periodically calls a corresponding Tuner function: Cy_CapSense_RunTuner(). The Tuner synchronizes data reading and firmware execution to preserve data coherency. CAPSENSE™ middleware waits for the Tuner read/write operation to be completed prior to execution of sensor scan and processing tasks. The Tuner does not read/write data until CAPSENSE™ middleware completes scanning and data processing tasks for all widgets in the application. The SNR and noise measurements are most accurate, and most tuning parameters can be edited in real time updating in this mode.
  - Asynchronized – When selected, the Tuner reads data asynchronously with sensor scanning and data processing. Due to this, data coherency may be corrupted. So, the Tuner may read only partially updated sensor data. For example, the device completed scanning of only the first sensor in a row. At this moment, the Tuner reads data of the latest scan from the first sensor and data of previous scans from the remaining sensor. This can occur to all sensors, when the Tuner reads data prior to the completion of data processing tasks, such as baseline update and filter execution. SNR and noise measurements are less accurate due to non-coherent data reading and only a limited set of tuning parameters can be edited in real time in this mode.
- Undoes the last action or sequence of actions. The same as the Edit > Undo menu command.
- Redoes the undone action or sequence of undone actions. The same as the Edit > Redo menu command.

4.3 Widget Explorer pane

The Widget Explorer pane contains a tree of widgets and sensors used in the CAPSENSE™ application. You can expand/collapse the Widget nodes to show/hide widget’s sensor nodes. You can check/uncheck individual widgets and sensors in the Widget Explorer pane. The widget checked status affects its visibility in the Widget View, while the sensor checked status controls the visibility of the sensor raw count / baseline / signal / status graph series in the Graph View and signals in the Touch Signal Graph on the Widget View.

Selecting a widget or sensor in the Widget Explorer pane updates the selection in the Widget/Sensor Parameters pane.

Note: For CSX widgets, the sensor tree displays individual nodes (Rx0_Tx0, Rx0_Tx1 …) contrary to the Configurator where the CSX electrodes are displayed (Rx0, Rx1 … Tx0, Tx1 …).
4.4 Widget/Sensor parameters pane

The Widget/Sensor parameters pane displays the parameters of a widget or sensor selected in the Widget Explorer tree. The grid is similar to the grid on the Widget Details tab in the CAPSENSE™ Configurator. The main difference is that some parameters are available for modification in the Configurator, but not in the Tuner. This pane includes the following parameters:

- **Widget General Parameters** – Cannot be modified from the Tuner because corresponding parameter values reside in the application flash widget structures that cannot be modified at runtime.
- **Widget Hardware Parameters** – Cannot be modified for the CSD widgets when CSD tuning mode is set to SmartSense (Full Auto-Tune) or SmartSense (Hardware parameters only) in the CAPSENSE™ Configurator. In Manual tuning mode (for both CSD and CSX widgets), any change to Widget Hardware Parameters requires hardware re-initialization performed only if the Tuner communicates with the device in Synchronized mode.
- **Widget Threshold Parameters** – Cannot be modified for the CSD widgets when CSD tuning mode is set to SmartSense (Full Auto-Tune) in the Configurator. In Manual tuning mode (for both CSD and CSX widgets), threshold parameters are always writable (Synchronized mode is not required). The exception is the ON debounce parameter that also requires hardware re-initialization (in the same way as the hardware parameters).
- **Sensor Parameters** – Sensor-specific parameters. The Tuner application displays only IDAC values or/and compensation IDAC value. The parameter is not present for the CSD widget when Enable Compensation IDAC is disabled on the Configurator CSD Settings tab. When CSD Enable IDAC auto-calibration or/and CSX Enable IDAC auto-calibration is enabled, the parameter is Read-only and displays the IDAC value as calibrated by the firmware. When auto-calibration is disabled, the IDAC value entered in the CAPSENSE™ Configurator appears, and the parameter is writable in Synchronized mode.
- **Filter Parameters and Centroid Parameters** – Cannot be modified at runtime from the Tuner because, unlike the other parameters, these parameter values reside in the application flash widget structures that cannot be modified at runtime.
- **Gesture Parameters** – Synchronized communication mode must be selected to update the Gesture parameters during runtime from the Tuner application.

*Note:* The position filter parameters, Adaptive IIR filter parameters, and Gesture parameters reflect data stored in a loaded configuration file. Actual values may vary on a target device connected to the CAPSENSE™ Tuner.

4.5 Tabs

The application consists of the following tabs:

- **Widget View** – Displays the widgets, their touch status, and the touch signal bar graph.
- **Graph View** – Displays the sensor data charts.
- **SNR Measurement** – Provides the SNR measurement functionality.
- **Touchpad View** – Displays the touchpad heatmap.
- **Gesture View** – Displays the Gesture operation.
4.6 Status bar

The status bar at the bottom of the GUI displays information related to the communication state between the Tuner and the device. Some sections differ depending on the communication type as follows:

### 4.6.1 I2C interface

| Refresh rate: 21 pkt/s | Bridge status: Connected | Slave address: 0x00 | I2C clock: 400 kHz | Supply voltage: 3.355 V | Logging: OFF |

### 4.6.2 UART interface

| Refresh rate: 42 pkt/s | Bridge status: Connected | Mode: Full duplex | Baud rate: 115200 | Supply voltage: 3.296 V | Logging: OFF |

- **Refresh rate** – A count of read samples performed per second. The count depends on multiple factors: the selected communication channel, communication speed, and amount of time for a single scan.
- **Bridge status** – Either Connected, when the communication channel is active, or Disconnected otherwise.
- **Slave address** – The address of the I2C slave configured for the current communication channel.
- **I2C clock** – The data rate used by the I2C communication channel.
- **Supply voltage** – The supply voltage.
- **Mode**
  - Full duplex mode – Provides data transmission in two reverse directions: target device → tuner → target device. In this mode, you can change the parameters of the widgets / sensors at Run-time. To save the new configuration, click the Apply to Device button.
  - Simplex mode – Provides data transmission in one direction: target device → tuner. In this mode, you cannot change the parameters of the widgets / sensors at Run-time.
- **Baud rate** – The data rate at which CAPSENSE™ operates with the current settings.
- **Logging** – Either ON (when the data logging to a file in progress) or OFF.
5 Tuner Communication Setup

The Tuner Communication Setup dialog is used to establish communication between the Tuner and target device. The Tuner supports I2C and UART communication interfaces.

Select Tools > Tuner Communication Setup… on the menu to open the dialog or click the Tuner Communication Setup button. The dialog opens automatically after clicking the Connect button if no device was previously selected.

Select the device and communication protocol by checking the item with the protocol name. Change the protocol configuration parameters to match the configuration of the communication peripheral in the application.

Note: The parameters in the Tuner Communication Setup dialog must be identical to the parameters of the I2C or UART driver in the application.

Recommended – enable the UART Flow control on the target device for bitrates equal or higher than 1000000.
6 Widget View tab

The Widget View provides a visual representation of all widgets selected in the Widget Explorer Pane. If a widget consists of more than one sensor, individual selected sensors are highlighted in the Widget Explorer Pane and Widget/Sensor Parameters Pane.

The Widget and/or sensors are highlighted when the device reports their touch status as active.

Some additional features are available depending on the widget type.

6.1 Touch Signal Graph

The Widget view also displays Touch Signal Graph. This graph contains a touch signal level for each sensor selected in the Widget Explorer Pane.

6.2 Toolbar

The toolbar provides quick access to different Tuner configuration options that affect the Widget View display.

- Zoom in – Zooms in the widgets.
- Zoom out – Zooms out the widgets.
- Graph – Shows or hides the Touch Signal Graph.
- Clear graph – Clears the Touch Signal Graph.
- Save image – Opens the dialog to save the Widget View tab as an image. Supported formats: .PNG, .JPG, BMP.
Graph View tab

The Graph View displays graphs for the sensors selected in the Widget Explorer Pane.

The following graphs are available:

- **Sensor Data** – Displays RawCount and Baseline. Click a corresponding check box to see them. Under Multi-frequency mode, RawCount and Baseline are available for three channels: 0, 1, 2.
- **Sensor Signal** – Displays signal differences.
- **Status** – Displays a sensor status (Touch/No Touch).
- **Position** – Displays touch positions for the Linear Slider, Radial Slider, and Touchpad widgets.

### 7.1 Toolbar

The toolbar provides quick access to different Tuner configuration options that affect the Tuner graphs display.

- **Number of samples** – Defines the total amount of data samples shown on a single graph.
- **Show / Hide legend** – Shows or hides the sensor series descriptions (with names and colors) in graphs.
- **Clear graph** – Clears all graphs.
- **Save image** – Opens a dialog to save the Graph View tab as an image. Supported formats: .PNG, .JPG, .BMP.

### 7.2 Graph functionality

The Pan and Zoom features allow you to examine graphs in more detail. Use a mouse drag for Pan. Use the mouse wheel for Zoom. The [Ctrl] key + mouse wheel zooms all graphs simultaneously. Press the [Esc] key to undo zoom and pan.

If you click a sensor line series on the graph, the corresponding sensor series highlights on the legend pane. Likewise, if you click a sensor series on the legend pane, it highlights a sensor line series on the graph. To highlight lines for all graphs at the same time, press and hold the [Ctrl] key before clicking. To select multiple sensors in the other Views, press and hold the [Alt] key while selecting the sensors.
Graph View tab

To change a sensor series color on the legend pane, double-click it. The “Please choose a color for …” dialog displays.

Select a color and click **OK**. To select a color for all the graphs at the same time, press and hold the **[Ctrl]** key while clicking.
8 SNR Measurement tab

The **SNR Measurement** tab allows measuring a SNR (Signal-to-Noise Ratio) for individual sensors. It provides the user interface to acquire noise and signal separately and then calculates a SNR based on the captured data. The obtained value is then validated by a comparison with the required minimum (5 by default, can be configured in the Options dialog).

At the top of the **SNR measurement** tab, there is a bar with the status labels. Each label status is defined by its background color.

- **Select sensor** – Green when there is a sensor selected; gray otherwise.
- **Acquire noise** – Green when noise samples are already collected for the selected sensor; gray otherwise.
- **Acquire signal** – Green when signal samples are already collected for the selected sensor; gray otherwise.
- **Validate SNR** – Green when both noise and signal samples are collected, and the SNR is above the valid limit; red when the SNR is below the valid limit, and gray when either noise or signal are not yet collected.

Below the top status labels bar, there are the following controls.

- **Sensor name** – The sensor selected in the [Widget Explorer Pane](#) or None (if no sensor selected).
SNR Measurement tab

- **Acquire Noise** – This button is disabled when no sensor is selected or communication is not started. When acquiring noise is in progress, clicking the button aborts the operation.
- **Acquire Signal** – This button is disabled when no sensor is selected, communication is not started, or noise samples are not yet collected for the selected sensor. When acquiring signal is in progress, clicking the button aborts the operation.
- **Result** – This label shows either N/A (when the SNR cannot be calculated due to noise/signal samples not collected yet), PASS (when the SNR is above the required limit), or FAIL (when the SNR is below the required limit).

Below the controls bar, there is the current status message and the progress of the current operation. Below the progress bar, there are three labels:

- **Noise** – Shows the last measured noise average value for the selected sensor, or N/A if no noise measurement is performed yet.
- **Signal** – Shows the last measured signal average value for the selected sensor, or N/A if no signal measurement is performed yet.
- **SNR** – Shows the calculated SNR value. This is the result of the Signal/Noise division rounded up to 2 decimal points. When an SNR cannot be calculated, N/A is displayed instead.
At the bottom, there is a chart that displays the measured sensor noise and signal. Noise and signal spikes displayed on the chart are points ignored during SNR calculation.

8.1 SNR options

SNR parameters can be modified in the options dialog. See Tuner Configuration Options for descriptions of other tabs on this dialog.

- Noise sample count – The count of samples to acquire during the noise measurement operation.
- Signal sample count – The count of samples to acquire during the signal measurement operation.
- SNR pass value – The minimal acceptable value of the SNR.
- Ignore spike limit – Ignores a specified number of the highest and the lowest spikes at noise / signal calculation. That is, if you specify number 3, then three upper and three lower raw counts are ignored separately for the noise calculation and for the signal calculation.
- Noise calculation method – Allows selecting the method to calculate the noise average. The following methods are available for selection:
  - Peak-to-peak (by default) – Calculates noise as a difference between the maximum and minimum value collected during the noise measurement.
  - RMS – Calculates noise as a root mean-square of all samples collected during the noise measurement.
- Progress bar text mode – This label is shown with the progress bar:
  - Hide (by default) – No label.
  - Percent – The number of samples in percent acquired during the signal measurement operation.
SNR Measurement tab

- Value – The number of samples acquired during the signal measurement operation.
- Signal graph below noise – Displays the signal series below the noise threshold on the graph.
- Show spike points – Highlights the spike points on the graph.
- Show legend – Shows the graph legend.

8.2 SNR Measurement procedure

1. Connect to the device and start communication (by pressing Connect, then Start on the toolbar).
2. Switch to the SNR Measurement tab.
3. Select a sensor by clicking it in the Widget Explorer Pane.
4. Ensure no touch is present on the selected sensor.
5. Press Acquire Noise and wait for the required count of samples to be collected.
6. Observe the Noise label is updated with the calculated noise average value.
7. Touch the selected sensor to produce signal on it.
8. Press Acquire Signal and wait for the required count of samples to be collected.
9. Observe the Signal label is updated with the calculated signal average value.
10. Observe the SNR label is updated with the SNR (signal-to-noise ratio).
9 Touchpad View tab

This tab visually represents signals and positions of a selected touchpad widget in the heatmap form. Only one CSD and one CSX touchpad can be displayed at a time.

*Note:* The Touchpad View tab is disabled when there are no touchpad widgets in the configuration.

9.1 Toolbar

- Zoom in – Zooms in the Touchpad widget.
- Zoom out – Zooms out the Touchpad widget.
- Clear – Clears the touchpad.
- Save image – Opens a dialog to save the Touchpad View tab as an image. Supported formats: .PNG, .JPG, .BMP.

9.2 Widget selection

Consists of the configuration options for mapping the physical touchpad orientation to the identical representation in the heatmap:

- CSD combo box – Selects any CSD touchpad to display in the heatmap.
- CSX combo box – Selects any CSX touchpad to display in the heatmap.
- Flip X-axis – Flips the displayed X-axis to match the orientation of a physical touchpad.
- Flip Y-axis – Flips the displayed Y-axis to match the orientation of a physical touchpad.
- Swap XY-axes – Swaps the X- and Y-axes for the touchpad.

9.3 Display settings

Manages heatmap data to display. These options are applicable for the CSX touchpad only.
**ModusToolbox™**
**CAPSENSE™ Tuner guide**

**Touchpad View tab**

- Display mode – The drop-down menu with 3 options for the display format:
  - Touch reporting – Shows current detected touches only.
  - Line drawing – Joins the previous and current touches in a continuous line.
  - Touch Traces – Plots all the reported touches as dots.

- Data type – The drop-down menu to select the signal type to display: Diff count, RawCount, and Baseline. Under Multi-frequency mode, RawCount and Baseline are available for three channels: 0, 1, 2.

- Value type – The drop-down menu to select the type of a value to display:
  - Current – The last received value.
  - Max hold – The maximum value out of latest “Number of samples” received.
  - Min hold – The minimum value out of latest “Number of samples” received.
  - Max-Min – The difference between maximum and minimum values.
  - Average – The average value of latest “Number of samples” received.

- Number of samples – Defines a length of history of data for the Line Drawing, Touch Traces, Max hold, Min hold, Max-Min, and Average options.

**9.4 Show signal**

Enables displaying data for each sensor if checked, otherwise displays only touches. This option is applicable for the CSX touchpad only.

- Display touch position – Selects the touchpad from which data is displayed in the heatmap. The three options:
  - Display only CSX
  - Display only CSD
  - Display both

- Color range – Defines a range of sensor signals within which the color gradient is applied. If a sensor signal is outside the range, a sensor color is either minimum or maximum out of the available color palette.

**9.5 Touch report**

- CSD touches table – Displays the current X and Y touch position (Z value is always 0) of the detected touches on the CSD touchpad. If the CSD touchpad is neither configured nor touch is detected, the touch table is empty. When two-finger detection is enabled for a CSD touchpad, then two touch positions are reported.

- CSX touches table – Displays the current X and Y touch position and Z values (amplitude) of the detected touches on the CSX touchpad. If the CSX touchpad is neither configured nor touches is detected, the touch table is empty. The middleware supports simultaneous detection up to three touches for a CSX touchpad touch, so the touch table displays all the detected touches.
10 Gesture View tab

This tab visually represents evaluation and tuning of gestures (from one widget at a time).

Note: The Gesture View tab is disabled when there is no gesture widget in the configuration.

Note: Synchronized communication mode or UART communication is recommended for Gesture validation, to make sure no gesture event such as a touchdown or lift-off is missed during communication.

10.1 Toolbar

- Open image – Opens a custom image.
- Reset position – Resets the image position and zoom. The image is moved to the center of the panel.
- Save image – Opens a dialog to save the Gesture View tab as an image. Supported formats: .PNG, .JPG, .BMP.

10.2 Widget selection

Allows selecting a widget and controls that the display in the Tuner matches the orientation physical widget on hardware.

- Combo box – Selects the widget with Gesture enabled to display the Gesture from it on this pane.
- Flip X-axis – Flips the direction of the X-axis to match the orientation of a physical widget.
- Flip Y-axis – Flips the direction of the Y-axis to match orientation of a physical widget.
- Swap XY-axes – Swaps the X- and Y-axes to match orientation of a physical widget.

10.3 Image pane

An image reacts to the detected gestures (scroll and zoom) and moves around the pane. You can change the image by clicking the Open image tool button.
**10.4 Gesture Monitor**

Provides visual indication for a detected gesture.

If the Delay checkbox is enabled, a Gesture picture is displayed only for the specified time-interval. If disabled, the last reported gesture picture is displayed until a new Gesture is reported.

**10.5 Gesture Event history**

Logs the detected gestures information.
11 Tuner Configuration options

The Tuner application allows setting different configuration options with the options dialog. The settings are divided into groups:

11.1 Display options

11.1.1 Theme

Defines the visual style of widgets.

Theme

Dark theme
11.2 SNR options

See the SNR options section for a description of this tab.

11.3 Logging options

- Log file – Selects a csv file and its location to store information.
- Append log to an existing file – If this option is enabled, the selected file cannot be overwritten and expanded with new data. When this option is not enabled, the selected file can be overwritten.
- Number of samples – Defines a log session duration in samples. The header is repeated after a number of samples.
- Data configuration check box table – Selects data to collect into a log file.
## 12 Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
</table>
| On common Linux distributions, the serial UART ports (usually /dev/ttySx or /dev/ttyUSBx devices) belongs to the root user and to the dialout group. Standard users are not allowed to access these devices. | An easy way to allow the current user access to the Linux machine's serial ports is by adding the user to the dialout group. This can be done using the following command:  
```bash
$ sudo usermod -a -G dialout $USER
```

*Note:* For this command to take effect, you must log out and then log back in. |
| On Linux, attempts to set up or start the CAPSENSE™ Tuner communication leads to the Tuner closing without any messages. | To enable Tuner communication under Linux, install the udev rules for KitProg3:  
- Disconnect the KitProg device.  
- Execute in the terminal (root access required):  
  ```bash
  sh $CYSDK/tools/fw-loader/udev_rules/install_rules.sh
  ```  
- Reconnect the KitProg device. |
| On macOS, the CAPSENSE™ Tuner can't be launched from the Launchpad. | Launch the Tuner from within the Device Configurator or use the command line option. |
| On common Linux distributions, the Tuner forbids communication protocol selection after re-plugging KitProg during communication. | Refer to the "Installation Procedure on Ubuntu Linux (x64)" section in the Cypress Programmer 2.1 CLI User Guide. |
| KitProg3 UART is accessible but not able to read data on Linux kernel 4.15 and above or Mac OS X 10.13 and above. | Use third-party UART to USB bridge.  
- Update the KitProg3 firmware to version 1.11.243 or above. |

*Note:* The Tuner provides information about the root cause of connection to KitProg in an operation log. The operation log location can be found in the About CapSense Tuner dialog.
# 13 Version changes

This section lists and describes the changes for each version of this tool.

<table>
<thead>
<tr>
<th>Version</th>
<th>Change descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>New tool.</td>
</tr>
</tbody>
</table>
| 1.1     | Added UART interface.  
          | Added possibility to save different views as images.  
          | Added zoom and pan functionality for graphs.  
          | Fixed minor issues. |
| 2.0     | Added "IDAC gain index" parameter.  
          | Changed the data storage location from a header (.h) file to an XML-based *.cycapsense file.  
          | For backward compatibility, the configurator is still able to load the header (.h) file that contains the legacy format configuration. But, if the legacy header (.h) with the configuration is passed via a command-line parameter, a message appears saying that the .h file is not supported.  
          | Added the Import and Export options to the File menu that enable importing and exporting the configuration file from and into the external file.  
          | Added the Reset View command to the View menu that resets the view to the default.  
          | Added Multi-frequency support that enables selecting RawCount and Baseline.  
          | Added the UART option description in Status Bar.  
          | Changed generation of the middleware initialization structure according to the changes in CapSense v2.0 middleware (related to added fields for flash memory optimization, fixed defect with RawCount filters config, IDAC gain index, etc.).  
          | Added support for selecting multiple sensors in some view and reflecting the selection in other views.  
          | Added handling of invalid command line arguments.  
          | Added highlighting of modified properties in the property grid with bold.  
          | Added a warning if opening a broken configuration file.  
          | Fixed memory leaks.  
          | Fixed Graph View issues under high load of application. |
| 3.0     | Added the Undo / Redo feature.  
          | Changed the list of UART baud-rate possible values to match the values supported by KitProg. The highest rate is 3000000.  
          | Updated versioning to support patches.  
          | Added a popup notification when the Apply to device command completes.  
          | Increased the communication speed between the device and Tuner when using the I2C interface.  
          | Improved the tool performance for loading large configurations.  
          | Fixed the issue with applying changes to the device when using the UART communication interface: now, many changes (>16) are applied correctly. |
| 3.10    | Updated versioning to support the updated backend, for detail, see Device Configurator user guide. |
| 3.11    | Removed from the GUI the possibility to change several UART settings (data bits, stop bits, parity) in order to match KitProg-supported values. The values used: data bits = 8, stop bits = 1, parity = none.  
          | Optimized the I2C interface communication to increase the speed. |
| 3.15    | Added support for the PSoC 4100S Max family.  
          | Added support for the CAPSENSE™ Middleware Library 3.0.  
          | Added a CSX touchpad sensor status display on the Graph view.  
          | Logging data from the device: removed the header duplication from the bottom of the pages of the file. |
| 4.0     | |
## Version changes

<table>
<thead>
<tr>
<th>Version</th>
<th>Change descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Changed the operation log file location. The new location can be found in the About CapSense Tuner dialog.</td>
</tr>
</tbody>
</table>
## Revision history

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>**</td>
<td>11/26/2018</td>
<td>New doc.</td>
</tr>
<tr>
<td>*A</td>
<td>12/05/2018</td>
<td>Documents were updated with changes requested in BVI-353.</td>
</tr>
<tr>
<td>*B</td>
<td>02/26/2019</td>
<td>Updated to version 1.1.</td>
</tr>
<tr>
<td>*C</td>
<td>10/16/2019</td>
<td>Updated to version 2.0.</td>
</tr>
<tr>
<td>*D</td>
<td>11/01/2019</td>
<td>Added section for launching from Device Configurator.</td>
</tr>
<tr>
<td>*E</td>
<td>03/27/2020</td>
<td>Updated to version 3.0.</td>
</tr>
<tr>
<td>*F</td>
<td>09/01/2020</td>
<td>Updated to version 3.10.</td>
</tr>
<tr>
<td>*G</td>
<td>12/14/2020</td>
<td>Updated to version 3.11.</td>
</tr>
<tr>
<td>*H</td>
<td>03/11/2021</td>
<td>Updated to version 3.15.</td>
</tr>
<tr>
<td>*I</td>
<td>09/29/2021</td>
<td>Updated to version 4.0.</td>
</tr>
</tbody>
</table>
IMPORTANT NOTICE
The information given in this document shall in no event be regarded as a guarantee of conditions or characteristics ("Beschaffenheitsgarantie").

With respect to any examples, hints or any typical values stated herein and/or any information regarding the application of the product, Infineon Technologies hereby disclaims any and all warranties and liabilities of any kind, including without limitation warranties of non-infringement of intellectual property rights of any third party.

In addition, any information given in this document is subject to customer’s compliance with its obligations stated in this document and any applicable legal requirements, norms and standards concerning customer’s products and any use of the product of Infineon Technologies in customer’s applications.

The data contained in this document is exclusively intended for technically trained staff. It is the responsibility of customer’s technical departments to evaluate the suitability of the product for the intended application and the completeness of the product information given in this document with respect to such application.

For further information on the product, technology, delivery terms and conditions and prices please contact your nearest Infineon Technologies office (www.infineon.com).

WARNINGS
Due to technical requirements products may contain dangerous substances. For information on the types in question please contact your nearest Infineon Technologies office.

Except as otherwise explicitly approved by Infineon Technologies in a written document signed by authorized representatives of Infineon Technologies, Infineon Technologies’ products may not be used in any applications where a failure of the product or any consequences of the use thereof can reasonably be expected to result in personal injury.

Trademarks
All referenced product or service names and trademarks are the property of their respective owners.